What Is It?

- Police Photography, Forensic Photography, Evidence Photography, Crime Scene Photography, Accident Photography .....?
- Forensic Photography is the fair and accurate recording of a scene or object, of legal interest, by a camera.
- “For the police photographer, photographs are statements of what he or she saw at a scene (Miller, p.9).”
Review of the Literature

- “Photography is a valuable tool for recording the crime scene and explaining the evidence to others.” (Staggs, p. 8).
- “The objectives of crime scene photography are to record the conditions of the scene before alteration, record the location and position of evidence items collected, document the point of view of principals and potential witnesses, and document spatial relationships of pertinent items.” (Ogle, p. 3).
The purpose of crime scene photography is to provide a visual record of the scene and related areas; to record the initial appearance of the crime scene and physical evidence; to provide investigators and others with the permanent record subsequent (sic) analysis of the scene; and to provide the permanent record to the court...crime scene photography is one of the most important steps in the entire investigation process. As one of the primary documentation components, systematic, organized visual record of an undisturbed crime scene must be achieved (Lee, et. al., pp. 80-81).”
A Few Basic Rules

- Do not disturb the scene: Photograph the scene as is before putting in scales and placards (Becker, p. 42)
- Get a complete series of images: overview, mid-range, close-up.
- Record all data: keep some kind of photo narrative. Some investigators keep a written log, others keep an audio log. Digital cameras will sequence images.
- Do not delete digital images on camera.
- Never review digital images on camera.
The Most Common Recurring Problems

- **Identification Problems:** There are no references to indicate the identity of the image. An example would be a magnified close up of bloodstain.
- **Orientation Problems:** What is right, left, up, and down.
- **Confusion Problems:** Has the scene been altered between images? When were the images taken.
- **Incomplete Documentation:** What was the systematic process, and have all crucial aspects been photographed.

(Taken from Gardner, pp. 131-134).
A Friendly Reminder

- You may be asked to testify about your images. The following is a typical scenario on testimony:

Q: Were you at 575 S. 10th, Lincoln, Lancaster County, Nebraska on July 4, 1971?
A. Yes

Q. Did you take photos at that location on the above date?
A. Yes

Q. I handed you what has been marked Exhibit 4. Do you recognize this?
A. Yes.

Q. Please describe Exhibit 4.
A. It is a copy of a digital image that I took. It is the front of the building at 575 S.10.

Q. Is it a fair and accurate representation as you saw it with your own eyes?
A. Yes.

Q. Has it been altered in anyway?
A. No. You might answer “I did not alter it, but I enhanced it by lightening the image using Adobe Photoshop CS.”

Q. After enhancing does it reflect a true and accurate representation of what you saw with your own eyes?
A. Yes.
What Can Be Explained?
The following slides launch into basic theory of photography.

This is important to understand for operation of the recording device, and so, if asked, you look like you know what you are doing when questioned on the witness stand.

Camera operation is considered from the use of a 35 mm camera. The basic techniques apply to digital cameras.
It is About Light

- The light spectrum: violet to red
- What is color? White is all colors. What you see is what is reflected.
- The inverse square rule. $1/x^2$, double distance and reduce light intensity to $\frac{1}{4}$.
- Shadows – good or bad?
- Creating contrast.
- Adding light.
Manipulating Light

- Camera Position
- Film or Sensor
- Shutter Speed
- ISO
- Aperture
- Flash or External Light Source
- Filter
- Hooding
- Exposure Control
Determining Correct Camera Settings

- Set Camera to automatic.
- Use the “Magic 16” rule. On a sunny day, use f-16 and the shutter speed closest to the ISO film speed. For ISO 100 use f-16 and 1/125.
- Use TTL (Through The Lens Metering) to get at least 1/60 for a hand hold shot. You will need to adjust the aperture.
- If your focus is on a dark carpet, as an example, you will need to back down two stops. Be aware of your focus point.
- Use flash or other external light source.
Composition

- The rule of 1/3’s: Place at 1/3 line or hot spots, or fill the frame.
- Perspective: join with depth of field.
- Reference: scale, street sign, landmark.
- Depth of Field: maximize
- Telling the Story: sequentially, thematically.
- Does It Truly and Accurately Reflect What You Saw?
Perspective

- Perspective refers to size and shape of objects and their depicted spatial relationships.

- In a two dimensional photographic or digital imaging, there are diminishing sizes and converging planes.

- Be careful of zoom images without an accompanying wider angle perspective. Close-up images can make objects look closer than they really are in real life. Wide angle can make images look stretched side to side. Close-up digital images, with some cameras, can give a fish bowl look (Sony Mavica CD-500 will do this).

- Know your camera!
Depth of Field

- Some photographers refer to depth of field as the same as perspective.
- For our purposes depth of field refers to the range in which objects are in focus.
- The “Hyper Focus” rule: Align the infinity mark, $\infty$, with the corresponding f-stop.
- Use the on camera scale
Depth of Field & Perspective
Parallel and Intersecting Planes

- Align the camera plane parallel with the surface. Another way to think of this is that the camera is at a level right angle (orthogonal) with the surface.

- This is very important for any photos of bullet hole, bloodspatter, pry marks, bite marks, shoe prints, tire tracks or other objects which might be used in a comparison.
Protocol

- Digital, 35mm, video.
- Check camera for settings.
- Overall (long range) around the compass, medium and close-up.
- With and without placards.
- With and without scales.
- Scene participants.
Documentation Categories

- Overall Photography
- Audio and Video Walkthrough
- Search and Numbering
- Specific Photography
- Close-up and Special Photography
- Measurements and Sketches
- Notes and Reports
Overall Photography

- Wide angle lens with 35mm, digital and/or video with zoom – outdoor/indoor.
- Move around the points of the compass.
- Show overall layout of scene, and spatial relationships.
- May need to repeat during the investigation.
Survey The Scene

- One role of the crime scene photographer is to capture as much information as possible relating to the scene.
- Consider the crowd and on-lookers when taking overall photos.
- Some agencies like to have a set of exit photos to include exterior overall photos.
Don’t Forget Identification and Orientation.

Where?

Tuesday, January 8, 13
Audio and Video Walkthrough

- Only done after consent or a search warrant, if protected property.
- This is a cursory examination, and not a thorough search.
- Often is done with the scene supervisor, and the audio photographer.
- Take the least intrusive path to avoid contamination – general description, temperature, condition of doors /windows, lights, and so forth.
Search and Numbering

- Most likely done in conjunction with specific photography.
- Systematic search – grid, strip, circular, up & down.
- Identify evidence with placard. Remember this is done after the photos without placards and scales.
Specific & Close-Up Photography

- Continuous throughout the scene process.
- Photos with and without placards and scales.
- Most likely will use 35mm camera with 50mm lens or digital camera.
- Bracket photos!
- Be in focus!
- Take your time!
Close-up Photography With Zoom Lens

- With and without scales. There must be at least one with a scale.
- With a 35mm with zoom, move the zoom all the way out and then move the camera to the object. Use the same process with a digital camera.
- A tripod is most likely in order.
Close-up Photography With Diopters or a Zoom Lens

- Stack diopters from largest to smallest.
- A tripod is required with a macro lens.
- Macro lenses can be very difficult to focus
Close-up Photography

- A tripod and remote shutter release are preferred.
- A 50mm lens and diopters is an inexpensive method.
- Sequence diopters, 4 +2 +1
- Focusing is crucial.
- Fill the frame.
- For night time, side light is preferred – hand held MagLite will work.
Close-Up Lens Practical

- Check your owners manual for the minimum focus distance. Some digital cameras will cause distortion. Others require activating the close-up feature.
- Fill the frame.
- Attach your camera to a tripod.
- Focus on a bullet casing. Scale?
- Set your shutter speed to 1/60.
- Maximize your aperture. What is it?
- Tech Tip: Move your camera to focus, and not the focus ring.
Using Flash

- Check your owner’s manual for in camera flash capabilities.
- What is the maximum distance for automatic?
- What is the maximum distance for manual.
- Focus your camera and set the flash unit to the appropriate f-stop and ISO. What is your flash synch setting?
Side Lighting

- This requires removal of the flash unit from the camera.
- Set the flash unit to the appropriate distance.
- Take from 12, 1:30, 3, 4:30 and 6 (n, NW, E, SE, S).
- Hold flash at approximately 30-45 degrees.
- Too low does not create contrast and shadow. Too high does not create shadow.
- Place scale at same plane as impression.
Side Lighting Photography

- Tripod and remote flash cord are preferred.
- Use several flash angles.
- Bracket photos
- Hand held MagLites with slow shutter speed will work.
- Focus and depth of field can be crucial.
- Figure is with MagLite.
Fill Flash Photography

- This is most often done to lighten a darkened area.
- It can be done in the same manner as painting with light, but with a much faster shutter speed in daylight.
- The photo at right is a Luminol photo, f 2.0, two minute exposure, then bounce flash from the ceiling of the shower.
Soft Lighting and Bounce Photography

- May be used when other lighting methods “burn out” the image.
- Bounce may be from an object, ceiling, wall, and so forth.
- Soft lighting can be diffused lighting – through a screen or thin paper.
- Soft light may be with flashlight.
Time Exposure

- Most often used with Luminol, Fluorescent, and Alternate Light Sources.
- Tripod and remote shutter release are preferred.
- With Luminol, an f2.0 and 45 second exposure are standard.
- Bracket all time exposures.
- Digital cameras are very sensitive, and make take less time.
Time Exposure

- A close-up object can be set on a time exposure and the object painted with a small flashlight.
- Time exposure in snow can be a good alternative to flash.
- UV and Infrared require long time exposure. Most digital cameras have a built in IR filter so you cannot do IR imaging without altering the camera. Know your camera!!.
Time Exposure of Snow Print

35 mm camera

Handheld mag lights by officers
Fire Scenes

- Fires may leave numerous obvious and subtle patterns.
- Fire damage may leave a very dark scene overall, with bright spots.
- It is very important to bracket photos at fire scenes.
- Consider enhancing flash settings by one. There is a tendency for photos to turn out dark.
Special Techniques - Snow

- Photographing at night, in snow, can present special problems.
- Soft light using MagLites is a possibility.
- Lightly dusting the impression with a “dry” fingerprint brush is an alternative.
- Follow local policy on dusting impressions – photo first without dust.
Painting With Light # 1

- A tripod and remote shutter release are required.
- Use a mid range f-stop (8 to 5.6).
- Set shutter speed on “B”.
- Open shutter and lock, and walk to side, flashing every 15’. (May cover shutter, uncover with each flash, recover).
- May use spotlight (?).
Painting with Light #2

- With a Digital Camera you may be able to stand behind the camera and repeatedly fire the remote flash.
- It is recommended to use at least two flashes, or a 1,000,000 candle power spot light.
- This can be done in 8 seconds. You need to “get’t done.”
- If you do not have a remote shutter capability, set the digital camera on a timer.
Painting with Light #3

- Digital Cameras are very sensitive to movement and color.
- If painting with light, the camera must be on a tripod.
- Be aware of the color of the light from the source. LED bulbs often give off a whiter light than traditional flashlight bulbs.
- When using a flashlight be sure to cover the entire image with light. Otherwise you will get a streaking affect or shadow effect in the image.
Filters in Forensic Photography

- A polarizing filter may be necessary to take photos through water or glass.
- Shading with a piece of cardboard might remove the glare.
Fluorescent Photography

- Requires, usually, tripod, remote shutter release, and barrier filter with standard 35mm camera.
- Usually requires about 15-30 seconds time exposure with 35mm.
- Orange 18 is good all around filter.
- Consider digital camera with barrier filter for real time photos.
Fluorescein Photography

- A 35 mm camera requires time exposure. The same as luminol photography.
- A real time image can be captured with a digital camera.
- Generally, an orange barrier filter will work.
- The image to the right was of a bloody shoe print, enhanced with fluorescein, using a 1.3 megapixel camera, handheld.
Time Exposure With Alternate Light

- Filters are usually required with an alternate light source.
- Bracket for time exposure from 15 - 45 seconds with 35mm.
- Digital cameras allow real time assessment of image capture.
- A tripod is required for a reliable sharp image.
What Is Missing – GSR On Coat Using Alternate Light Source?
Notes and Reports

- Store your field notes (?)
- Reports should be accurate and reflect all information you gathered during the investigation.
- Be careful with opinions and rambling observations.
- Inventory photos.
- Inventory and log evidence.
Notes and Reports

- Establish and maintain a chain of custody.
- Prepare a photo log – consider notating on the back of the photo.
- Field notes can be considered exculpatory information.
- Did you remember times?
- Has all evidence been dated and initialed?
Forensic Photography Overview

- Cameras – snapshot, 35mm, video, digital.
- Specific Aspects Of The Camera – film speed, sync flash, shutter speed, f-stop, flash setting, depth of field scale, focusing ring.
- Special Equipment – tripod, remote flash cord, remote shutter release cable, filters, scales or rulers.
- Check your settings, hold your camera at eye level or fill the frame unless special considerations, tripod when necessary, check for light, bracket, do not delete on camera.
Flash and Time Exposure Practical

- Set your flash for a side light photo of an impression in the dirt.
- Fill flash an object underneath a vehicle.
- Paint the classroom.
- Paint your fingertip.
- Photo an object on glass.
Digital Image Enhancement

- All enhancement techniques are done, for this course, using Adobe Photoshop CS. This is because NWU has this software on the computers in the lab.
- There are other image editing software that work very well.
- The following slides are reference slides. We will do practicals in the lab.
Imaging Sizing 1:1 (* using Mr. Witzke’s, Foray Technology Techniques.)

- Activate Adobe Photoshop > Open > select image.
- Select crop tool, “C”, or from tool palette.
- Crop image by selecting a distance on the scale – remember this distance.
- Double Click on the cropped area.
- Image > Resize > Resample is off > type in cropped distance. Make sure the measure units are the same as thee on the scale, i.e., mm, cm, inches, etc. Notice that when you put in a value, all of the others change.
- Highlight the new resolution and copy, Cntrl C.
- Cancel > kill the crop with Ctrl Z.
- You should be back to the original image.
- Image > Resize > Paste in resolution by Ctrl V > OK.
- Your image is now approximately 1:1.

*Taken from [http://www.foray.com/calibratingimages.htm](http://www.foray.com/calibratingimages.htm).
Image Sizing 1:1 (* using the technique of Mr. George Reis)

- Activate Adobe Photoshop > Open > select image.
- View > Rulers > select desired scale.
- Image > Resize > Resample Off > enter 1 in Resolution and select pixels/cm.
- Zoom into your image > use measure tool to select 1 cm. Note the number of pixels in the D at the top of the screen.
- Enter the number of pixels in Image Resize resolution box.
- Your image is now 1:1.
- You can now measure parts of your image on screen.
Image Enhancement

- You must keep track of all steps!!.
- Invert. Use this to presumptively identify bloodstains.
- Image > Adjustments > Levels. Use this to darken, lighten, adjust colors and hue. Write down all steps. You can use this to fill flash a dark image. It is very useful to highlight GSR on clothing. It is very useful to detect changes in ink, as an example.
Enhance Images

SPECIAL
$5.00 OFF MANICURES +

Manicure Reg. 21.00 Sale 16.00
Basic Pedicure Reg. 34.00 Sale 29.00
SPA Pedicure Reg. 44.00 Sale 39.00

W/ Margaret ONLY
Comparing Images

- This is used to compare to images with similar characteristics. It can be used to compare tire tracks, footprints, bite marks, fingerprints, and so forth. It is a field technique!!
- Open > get two images > arrange side by side. Put the known on the left and the suspect on the right.
- Put all images 1:1. Now select the one with the lowest resolution. Copy this resolution. Go to the other image, check Resample, copy this resolution into the resolution box. **Both images are 1:1, and then both images are set to the same resolution.**
- Select the image on the right. Layer > Duplicate Layer or New Layer. Select this Duplicate Layer from the Layer Palette.
- Duplicate Layer > adjust Opacity to 45%.
- Get move tool from Toolbox. Place move tool on a spot on the Duplicate Layer. Drag the Duplicate Layer onto the Known image.
- Maneuver to compare images..
Compare Images

Image on mylar: recovered with static dust lifter

Suspect shoe (issues?)
Admissibility of Digital Images

- Do not alter, enhance, or view on camera – the JPEG rule is very important.
- Work from copies – never the original.
- Write down all steps sued when enhancing images.
- If you altered, then you altered. If you resized, adjusted brightness, made layers for comparison, you enhanced. If you changed colors for comparison, you may have altered or you may have enhanced.
References

See You On the Job

Fluorescent powder, orange filter

Fluorescein enhancement of blood, orange filter